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Resumo

O presente artigo trata-se do desenvolvimento de um
protétipo de jogo em Realidade Aumentada para o
Ensino de Ciéncias no intuito de possibilitar aos
estudantes a apropriacdo de alguns conceitos referentes
a classificagdo dos seres vivos. Esse artigo tem como
objetivo apresentar o protdtipo de um jogo em
Realidade  Aumentada  denominado  “Tabuleiro
Aumentado”. De acordo com a base tedrica utilizada
no desenvolvimento deste trabalho, é possivel
compreender que a Realidade Aumentada, apesar de
ser apontada como uma tecnologia recente e em pleno
desenvolvimento nos laborat6rios de pesquisa, vem
recebendo muita atencdo recentemente, sendo
considerada madura e robusta em vérias &reas do
conhecimento. Para o embasamento teorico e as formas
de apropriacdo da tecnologia, se utilizou os estudos de
Yuen, Yaoyuneyong e Johnson [2011], que
apresentaram algumas possibilidades para sua
apropriacdo no contexto da educacdo, sendo estas: AR
Books; AR Gaming; Discovery-based Learning;
Objects Modeling e Skills Training. Para o
desenvolvimento do jogo Tabuleiro Amentado, foi
utilizado a Game Egine Unity 3D integrada a
biblioteca de RA Vuforia. O jogo apresentado neste
artigo propde uma forma diferenciada para a
aprendizagem de temas relacionados aos seres Vvivos,
como a Classificacdo, Hbitat e as Caracteristicas dos
filos dos organismos. O que se pretende com 0s
recursos desenvolvidos, € que 0S mesmos sejam
recursos auxiliares para a aprendizagem, que pode ser
favorecida por meio da visualizagdo e integracdo de
objetos virtuais a0 mundo real no contexto onde 0s
estudantes estdo inseridos. O préximo passo serd a
validacédo e avaliacdo do protétipo com a mediagdo de
professores de Ciéncias dos anos finais do Ensino
Fundamental. Pretende-se que o recurso desenvolvido
seja disponibilizado para utilizacdo sem fins lucrativos.
Pretende-se ainda como proposta para uma segunda
pesquisa, apresentar os resultados das apropriacdes do
jogo Tabuleiro Aumentado no contexto educacional
como contribuicio deste estudo.
Palavras-chave: Aprendizagem, Ciéncias, Ensino
Fundamental, Realidade aumentada
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1. Introducéo

A Base Nacional Comum Curricular (BNCC)
amparada na a Lei de Diretrizes e Bases da Educagéo
(LDB) e no Plano Nacional de Educacdo 2014,
orientam a area das Ciéncias Naturais a organizar
situacdes de aprendizagem partindo de questBes que
sejam desafiadoras e que estimulem o interesse e a
curiosidade dos estudantes para definir problemas,
levantar hipdteses, analisar resultados e propor
intervencgoes [Brasil 2017].

Para que isso ocorra, essas situacdes devem estar
atreladas ao planejamento e as diferentes estratégias
didaticas de cada escola. Neste contexto, as
Tecnologias Digitais da Informacdo e Comunicagéo
(TDIC), podem apresentar possibilidades para o
ambiente escolar, por desempenhar diferentes papéis
[Valente 2014] podendo ser apropriadas como
ferramentas mediadoras de aprendizagens [Beraldo e
Maciel 2016] para os estudantes.

Conforme Brasil [2017], ao utilizar as linguagens
das TDIC, estudantes e professores tem a possibilidade
de se comunicar, acessar e disseminar informacdes,
produzir conhecimentos e resolver problemas das
Ciéncias da Natureza de forma critica, significativa e
reflexiva.

Neste contexto, chamamos atencdo para o que é
definido pela BNCC como as aprendizagens essenciais
a ser asseguradas pelo componente curricular das
Ciéncias Naturais [Brasil 2017]. Dentre elas,
destacamos as caracteristicas dos seres vivos que
conforme o documento norteador, nos anos iniciais e
finais do Ensino de Ciéncias devem ser trabalhadas a
partir das ideias, representacBes, disposicBes
emocionais e afetivas que os estudantes trazem para a
escola.
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Todavia, referente ao estudo dos seres vivos,
algumas dificuldades sdo encontradas decorrentes dos
termos e nomes das categorias taxondmicas [Dalmolin
e Lewandowski 2013]. Acredita-se que tais
dificuldades estejam relacionadas ao fato de as
Nomenclaturas Bioldgicas dos organismos terem raizes
nas linguas grega ou latina, sendo a segunda (latina)
uma lingua morta, cujos conceitos sdo universais a
Nomenclatura Zoolbégica dos organismos [Moreira
2004], ndo sofrendo alteracbes no significado das
palavras com o passar dos anos.

Além do conhecimento de que os nomes dos seres
vivos devem ser universalmente conhecidos, conforme
0 componente curricular das Ciéncias Naturais,
descrever caracteristicas como tamanho, forma e cor
desses organismos € uma habilidade que o estudante
deve desenvolver para relaciond-los ao ambiente em
que eles vivem [Brasil 2017].

Dessa forma, o presente trabalho buscou o
desenvolvimento de um aplicativo em Realidade
Aumentada (RA), no intuito de possibilitar aos
estudantes a apropriacdo de alguns conceitos referentes
a classificacdo dos seres vivos.

O prototipo do aplicativo em RA denominado
“Tabuleiro Aumentado” foi desenvolvido para ser
incorporado as aulas de Ciéncias como um recurso
complementar. A escolha dos recursos em RA se deu
pelo fato de que a tecnologia permitira que estudante
visualize e interaja com o0s objetos em 3D por meio dos
seus smartphones.

Outro ponto que em nosso entendimento foi
relevante para a escolha da RA, teve base nos estudos
de Yuen, Yaoyuneyong e Johnson [2011] que
apresentaram algumas possibilidades para sua
apropriacdo no contexto da Educacéao, sendo estas: AR
Books; AR Gaming; Discovery-based Learning;
Objects Modeling e Skills Training.

A ideia que norteia a forma de apropriacdo do
recurso desenvolvido, inicialmente segue a dire¢do AR
Gaming, uma vez que o aplicativo foi pensado para ser
usado em modo desafio junto a um tabuleiro fisico, em
que o professor tera a possibilidade de avaliar a
aprendizagem dos conceitos trabalhados em sala de
aula.

O objetivo desse artigo é apresentar o prot6tipo de
um jogo em realidade aumentada denominado
“Tabuleiro Aumentado”.
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O artigo esta dividido nas seguintes secdes: sec¢do 2
estdo os referencias tedricos trazendo alguns conceitos
da tecnologia selecionada para o desenvolvimento do
prototipo. Na secdo 3 estd a metodologia e na secéo 4
estd a descricdo do processo de desenvolvimento do
aplicativo em RA. Por fim, na secdo 5 estdo as
consideracOes e 0 que se pretende apds os testes dos
recursos desenvolvidos.

2. Referencial

Nesta secdo, serdo apresentados alguns conceitos e
possibilidades da RA para a Educagéo.

2.1 O aumento darealidade

A evolugdo de tecnologias como computadores e
dispositivos moveis [smartphones e tablets] promoveu
o desenvolvimento de diferentes tipos de recursos. Para
Tori [2010], a capacidade de processamento, o0
barateamento, a velocidade da comunicacdo e a
disponibilidade de aplicativos gratuitos desenvolvidos
para esses artefatos foram fundamentais para a
consolidacdo de vérias tecnologias, dentre elas a RA.

Segundo Kirner e Kirner [2007], a RA combina
recursos de multimidia e Realidade Virtual (RV) para
representar elementos misturados de boa qualidade e
prover interagdo em tempo real. Conforme os autores,
a combinag8o dessas tecnologias ndo faz com que o
senso de presenga no mundo real seja perdido, uma vez
que, em um sistema de RA, a sensacdo de presenca no
mundo real é mantida.

Referente ao que é real ou virtual, as defini¢des
estdo inseridas em discussdes profundas, como
exemplo, os conceitos encontrados em Levy [2003;
1997], em que o filosofo apresenta trés sentidos para
definir o que é virtual.

Conforme Levy [1997], o primeiro sentido ¢é
técnico, tendo seu conceito ligado a informatica; o
segundo encontra-se em um sentido corrente, em que a
palavra virtual é agregada a irrealidade, enquanto a
realidade se refere & efetivagdo material, sendo esta
uma presenca tangivel.

No terceiro sentido, sendo este entendido pela
acepcao filoséfica, Levy [1997] define como virtual
aquilo que existe apenas em poténcia e ndo em ato,
sendo o virtual uma dimensdo muito importante da
realidade onde o virtual ndo se opde ao real, mas sim
ao atual.
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Apesar da existéncia de dimensfes mais amplas
acerca do que € real ou virtual conforme os conceitos
discutidos em Levy [1997; 2003], o termo virtual,
conforme Tori, Hounsell e Kirner [2018], ja é de uso
comum quando nos referimos aos objetos ou ambientes
desenvolvidos por meios digitais.

Neste contexto, mesmo nédo atendendo com rigor as
definicBes encontradas em Levy [1997; 2003], nos
apropriamos das definicdes encontradas em Rodello e
Brega [2011] e Tori, Hounsell e Kirner [2018].

Conforme os autores, entende-se como um
ambiente virtual aquele totalmente gerado por
computador, sintetizado por meio de dispositivos
digitais, podendo ser replicado de forma imaterial.

Referente ao que é real, neste trabalho, serd
considerado todo o ambiente ou elemento que o
individuo considere como sendo pertencente a sua
realidade [Tori, Hounsell e Kirner 2018]. Neste
contexto, consideramos tudo aquilo que € captado por
nossos sentidos, podendo ainda ser palpavel ao nivel de
objeto.

Vale destacar que os conceitos de RA, se baseiam
nesses dois ambientes (real e virtual). Essa afirmativa é
reforcada a partir das definicBes encontradas na
literatura existente sobre essa tecnologia [Tori, Kirner
e Siscouto 2006, Kirner e Siscouto 2007, Fialho 2018;
Tori, Hounsell e Kirner 2018] tendo base tedrica, os
conceitos encontrados em Milgran [1994], e Azuma,
[2001] que definem RA como:

1) a mistura dos mundos reais e virtuais em algum
ponto do espectro que combina os ambientes
completamente reais aos ambientes completamente
virtuais [Milgran 1994];

2) um sistema que suplementa o0 mundo real com
elementos  virtuais gerados por  computador,
proporcionando o sentido da coexisténcia no mesmo
espaco tendo as seguintes propriedades:

a) combina elementos reais e virtuais no ambiente
real;

b) executa interativamente em tempo real;
c) alinha objetos reais e virtuais entre si [Azuma et
al. 2001].

A combinacdo desses elementos e ambientes pode
ser entendida a partir do Continuum de Milgran [1994],
conforme ilustra a figura 1.

343
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Reality-Virtuality (RV) Continuum

Figura 1: Continuum de Milgram [1994].

A proposta deste diagrama, € estabelecer a
transicdo entre a realidade e a virtualidade. Neste
sentido, percebe-se que a RA é apresentada como o
ambiente mais proximo do real, enquanto a
Virtualidade Aumentada (VA), momento no qual o
mundo virtual é enriquecido com representacbes de
elementos reais [Kirner e Kirner 2011] € apresentada
como 0 ambiente mais proximo do virtual.

Neste contexto, em uma extremidade estd o
ambiente constituido apenas de objetos reais (ambiente
real), enquanto na outra extremidade estd o ambiente
totalmente virtual composto apenas de objetos virtuais.

Conforme o Continuum de Milgram [1994],
partindo da extremidade real com um aumento
gradativo da quantidade de elementos virtuais
integrados ao ambiente real, é possivel chegar a um
ambiente de RA propriamente dita. Quando ocorre a
predominancia do ambiente virtual, tem-se a VA.

Vale destacar que, conforme as defini¢cGes
encontradas em alguns autores [Milgram 1994; Tori
2010; Kirner e Kirner 2011], tanto RA quanto VA,
vem sendo inseridas dentro de um conceito mais amplo
denominado Realidade Misturada (RM).

Dessa forma, no contexto da realidade mista, a RA
poder ocorrer quando objetos virtuais sdo integrados ao
mundo real [Tori, Kirner e Siscoutto, 2006]. Quando
objetos reais sdo inseridos no mundo virtual, por meio
de representac@es realistas, prevalecendo as interagdes
virtuais, tem-se a VA [Kirner e Kirner 2011] sendo
ambas as realidades (RA e VA), casos particulares da
realidade mista.

Embora alguns autores defendam que néo fica claro
como ocorre a transicdo da RA para a VA dentro desse
continuum, para Kirner e Kirner [2011] o tipo de
interacdo no ambiente misto é que define se o sistema é
de RA ou de VA, independente da quantidade de
objetos reais e virtuais presentes no ambiente.

Pela dificuldade de se estabelecer dentro do
Continuum de Milgram [1994], como ocorre a
transicdo da RA para VA e desta para a RV, em nosso
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entendimento, a melhor definicdo para representa o
conceito de RA, é a encontrada em Azuma et al.
[2001], o que se justifica, pela mesma trazer um maior
detalhamento dos componentes e funcionalidades de
um sistema em RA.

Vale destacar que, a definicdo defendida por
Azuma et al. [2001], vem sendo a mais aceita pelos
autores que serviram de base tedrica para ©
desenvolvimento deste artigo.

2.2 RA no contexto da educacéao

A RA, apontada como uma tecnologia recente e em
pleno desenvolvimento nos laboratérios de pesquisa
[Tori  2010], vem recebendo muita atengdo
recentemente, e conforme Tori, Hounsell e Kirner
[2018], ja estd madura e robusta em varias areas do
conhecimento.

Por meio de uma Revisdo Sistematica de Literatura
(RSL), realizada nas bases de dados IEEE Xplore
(IEEE), ProQuest, AIS Electronic Library (AlSeL), e
ACM Digital Library (ACM), relacionadas as
disciplinas da &rea de Sistema de Informagdes, e em
base de dados gerais como EBSCO Host (EBSCO) e
ScienceDirect, Diegmann et al. [2015], apresentam e
categorizam alguns beneficios da RA para ambientes
educacionais.

Os autores identificaram alguns beneficios, citando
exemplos da literatura revisada. Conforme Diegmann
et al. [2015], os beneficios apresentados foram:
aumento da motivacdo e atencdo, aumento da
concentracdo e maior satisfacdo dos estudantes que
conforme os autores, se mostraram bastante satisfeitos
em aprender por meio de ferramentas de RA.

Em concordancia pelo que foi apresentado pela
pesquisa de Diegmann et al. [2015] a respeito da
motivacdo para aprender, Chang, Wu e Hsu [2013],
explicam que isso ocorre por meio da possibilidade da
RA acrescentar elementos que pode levar a apreenséo
de conceitos cientificos por parte dos estudantes.

Para os autores, a combinacdo de RA com as
atividades de pesquisa pedagogica pode possibilitar
gue os estudantes compreendam os conteldos de
Ciéncias, focando também as questées do mundo real,
promovendo, a alfabetiza¢do em Ciéncias.

Ainda referente as possibilidades da RA para o
contexto da Educacdo, outro estudo que destacamos
neste artigo, foi o realizado por Yuen, Yaoyuneyong e
Johnson [2011], que analisaram cinco modos de
apropriacdo educacionais com RA. Para os autores as
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propostas sdo significativas para o contexto educativo
sendo elas: AR Books; AR Gaming; Discovery-based
Learning; Objects Modeling e Skills Training.

2.2.1 AR Books / Livros com RA

Conforme Yuen, Yaoyuneyong e Johnson [2011], os
livros com elementos de RA, abrirdo novas
possibilidades para arte da ficcdo, além de possibilitar
novas formas de contar histérias em uma interface
totalmente nova.

Por oferecer apresentacbes em 3D com
interatividade, Fialho [2018] explica que os primeiros
experimentos com livros em RA tém demostrado que
essa tecnologia tem potencial para atrair os estudantes,
principalmente no nivel primario.

Porém, Yuen, Yaoyuneyong e Johnson [2011]
explica que, essa interface totalmente diferente de
livro, exigira uma maior atencdo por parte dos
desenvolvedores para questdes como: a coesdo dos
livros, a qualidade e a imersdo.

Todavia, os autores destacam o potencial dos livros
em RA para os estudantes e para os professores.

2.2.2 AR Gaming / Jogos em RA

Neste modo de apropriagdo da RA no contexto
educacional, Yuen, Yaoyuneyong e Johnson [2011]
defendem que, frequentemente, os professores utilizam
jogos para ajudar os estudantes compreender conceitos
em diferentes disciplinas.

Por meio de jogos em RA, os professores podem
oferecer novas formas para que os estudantes interajam
com outros estudantes, com os contetdos, com o
ambiente e com o professor.

Para os autores, 0s jogos que usam a tecnologia de
marcadores, geralmente incluem um tabuleiro de jogo
plano ou mapa com elementos 3D virtual, combinados
ao ambiente fisico real, podendo ser visualizado por
meio de um dispositivo mével ou uma webcam.

Ainda conforme os autores, esse tipo de jogo pode
ser desenvolvido em diferentes areas do conhecimento

como Arqueologia, Histéria, Antropologia ou
Geografia como exemplos.
2.2.3 Discovery-based Learning /

Aprendizagem baseada em descoberta

Outra possibilidade da RA para a Educacdo é
possibilitar que a aprendizagem ocorra por meio da
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descoberta [Yuen, Yaoyuneyong e Johnson 2011].
Essa forma de aprendizagem pode ocorrer em
diferentes lugares como exemplo, em um museu,
laboratério ou até mesmo em locais histéricos de uma
cidade.

Neste contexto, os aplicativos em RA que
transmitem informag6es sobre um lugar do mundo real,
e permitem a identificacdo de plantas e animais, abrem
as portas para o que € considerado pelos autores como
aprendizagem investigativa, interativa e independente.

Para os autores, essa forma de apropriacdo pode
ocorrer por meio de uma webcam ou smartphones,
tendo potencial para o desenvolvimento de atividades
em diferentes areas conhecimento como, Biologia,
Quimica, Inglés, Matemética, Fisica, Linguas
Estrangeiras, Educacdo Fisica entre outras.

2.2.4 Objects Modeling / Modelagem de
objetos

Nesse modo de apropriacdo, a RA pode ser usada na
modelagem de objetos, permitindo que os estudantes
visualizem como um determinado objeto ficaria em
diferentes configuracoes.

Os autores citaram como exemplo, a Faculdade
Mauricio de Nassau no Brasil, em que os estudantes de
arquitetura exploraram as possibilidades de usar a RA
para projetar modelos de edificios em escala,
otimizando o tempo necessario para construir e
apresentar propostas arquitetonicas.

2.2.5 Skills
habilidades

Training / Treinamento de

Para Yuen, Yaoyuneyong e Johnson [2011] outra
funcdo educacional em que a RA poderd ser
promissora seré na area de treinamento de habilidades.

Para os autores, a RA tem um forte potencial para
proporcionar experiéncias de aprendizado. Dentre 0s
exemplos citados pelos autores, estdo os treinamentos
realizados com pessoas usando 6culos de RA em
tarefas especificas como: mecénica de hardware no
servico militar e em manutencdo de avies, em
empresas como a Boeing.

Com base nas formas de apropriagdo e nas
possibilidades elencadas por meio da RA nas pesquisas
de [Diegmann et al. 2015; Yuen, Yaoyuneyong e
Johnson 2011], seguimos para a proxima secdo deste
trabalho  descrevendo o  procedimento  de
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desenvolvimento do jogo educativo Tabuleiro
Aumentado para o ensino de Ciéncias.
3. Desenvolvimento do jogo
Nesta secdo, estdo descritos 0s processos de
desenvolvimento do jogo educativo “Tabuleiro

Aumentado”. Trata-se de uma breve descricdo a
respeito do motor de jogo escolhido, da biblioteca de
integracdo dos recursos em RA, modelagem do
tabuleiro e os demais processos utilizados para a
construgéo do recurso desenvolvido.

3.1 Motor de jogo

Para o desenvolvimento do jogo Tabuleiro Amentado,
foi utilizado a Game Egine Unity 3D, um motor para o
desenvolvimento de jogos 2D/3D, que permite o
desenvolvimento de diversos géneros de jogos, e
diferentes tipos de aplicativos [UNITY3D, 2015],
como exemplo, os aplicativos em RA.

A escolha da Egine se deu pela mesma apresentar
um rico ambiente que permite importar objetos 3D em
diversos formatos, podendo também ser integrada a
outras bibliotecas de RA, como exemplo a Vuforia.

3.2 Biblioteca de integracéo

Vuforia é uma biblioteca de RA originalmente
desenvolvida pela Qualcomm e recentemente
comprada pela PTC [Vuforia, 2018] podendo ser
integrada a algumas plataformas de desenvolvimento
de jogos.

E a plataforma mais usada para desenvolvimento de
recursos em RA, tendo suporte para 0s principais
dispositivos moveis [Vuforia, 2018] permitindo o uso
de um banco de dados em nuvem para hospedar e
gerenciar marcadores para o desenvolvimento de
diferentes tipos recursos.

Por ser compativel com a Unity, podendo ter seus
recursos facilmente integrados pela engine, e pela
possibilidade de utilizacdo das cAmeras de smartphones
[Zorzal e Silva 2018], esta biblioteca foi fundamental
para o desenvolvimento do aplicativo em RA.
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Q Unity 2018.2.14f1 Personal (64bit) - SampleScene.unity - New Unity Project (1) - Android* <DX11 on DX9 GPU>

File Edit Assets GameObject Component Window Help
Ctrl+Shift+N
Alt+ShiftsN

Create Empty

Create Empty Child
3 Object >
2D Object >
Effects >
Light >
Audio >
Video >
ul >
Vuforia > AR Camera

Camera
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Center On Children Multi Image

Make Parent Cylindrical Image

Clear Parent Cloud Image >
Camera Image >
Model Target

3D Scan

Apply Changes To Prefab

P Break Prefab Instance
[l Console

[Clear || Collapse [C et as first sibling Ctrl+=

Figura 2: Possibilidades de ihfegragﬁo
da Unity3D com a biblioteca Vuforia.

Essa possibilidade de integracdo permite que a
biblioteca reconhega e faga o rastreamento de uma
ampla gama de objetos 3D.

3.3 Modelagem do Tabuleiro e
Desenvolvimento dos Cards
A modelagem do tabuleiro e o0s marcadores

denominados “Cards” foram desenvolvidos no Adobe
PhotoshopCs6. Em seguida, os marcadores foram
inseridos na biblioteca Vuforia, em que foram criadas
as Tagts dos marcadores e gerado um arquivo
unitypackage para ser importado pelo Unity.

Import Unity Package

RA1 (2)

¥ o G editor

¥ M & vuforia

¥ M G tmageTargetTextures

GERAL
|em10_scaled.jpg
™ mi11_scaled.jpg
™ mi12_scaled.jpg
& |mil13_scaled.jpg
o mi14_scaled.jpg
™ lmi15_scaled.ipg
™ i 16_scaled.jpg
o |m17_scaled.jpg
o lm/1_scaled.jpg
¥ lmi|2_scaled.jpg
™ i 3_scaled.jpg
o mia_scaled jpg

v i

O Console

Figura 3. Arquivo unitypackage do VVuforia sendo
importado na Unity.

Em seguida, os marcadores, que sdo cartbes que
permitem o uso da técnica de visdo computacional
[Tori 2018] foram integrados aos objetos em 3D
visando a funcionalidade do jogo.
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Figura 4: Desenvolvimento no Unity

Para um melhor entendimento, a base para o
funcionamento do jogo em RA, serd a capacidade do
sistema computacional identificar onde os elementos
virtuais em 3D aparecerdo, 0 que nesse caso Sera no
tabuleiro fisico, ativados por marcadores impressos.

Alguns  objetos em 3D utilizados no
desenvolvimento deste jogo foram modelados no
Blender3d. Ainda foram realizados downloads de
outros recursos em 3D nas plataformas Unity Asset
Store e Free3D.

= 10 Vodes

A 0 »%» 72 «# 0 ¢ ¥ ¢+

Free 3D animals Models / oo

ALSOCHECK THESE 4068

Game ety

Figura 5: Biblioteca Free 3D models.

O projeto desenvolvido foi exportado para ser
utilizado como aplicativo para android e para e
Windows. Em seguida, foram realizados alguns testes
para verificar seu funcionamento no intuito de
identificar e corrigir possiveis erros.

Os testes foram realizados em um computador
equipado com uma webcam e em dispositivos méveis
como smartphone e tablets.
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Figura 6: Teste realizado no computador
com webcam

Para a realizagdo dos testes, foram utilizados
marcadores impressos que serdo os cards do jogo.

4. Resultados do desenvolvimento

Nesta secdo, sera apresentado o processo de
desenvolvimento do prototipo em RA “Tabuleiro
Aumentado” como recursos de apoio para as aulas de
Ciéncias no Ensino Fundamental. O aplicativo foi
desenvolvido para ser utilizado em um jogo do tipo
desafio em um tabuleiro.

4.1 Tabuleiro Aumentado em RA

Trata-se de um jogo de tabuleiro do tipo desafio
admitindo dois jogadores por rodada. Cada jogador
recebera 10 cards impressos sendo os ativadores para
as projecdes em 3D de RA.

A proposta do jogo é possibilitar aos estudantes,
uma forma lddica para a aprendizagem dos contedidos
relacionados aos seres vivos, suas caracteristicas e
relagdes com o meio ambiente.

A proposta € que o jogo ocorra em modo desafio,
em que um estudante desafiara o outro estudante. O
jogo também poderd ocorrer em modo equipe, tendo o
professor como mediador durante todo o processo em
gue os cards serdo inseridos no tabuleiro fisico
previamente impresso.

Os cards séo classificados como card de “insergdo”
com ativadores das projecdes dos organismos em RA e
card de “Combinagdo”, com os filos referentes aos
organismos inseridos no tabuleiro.
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Figura 7:Tabu|eiro para insercdo dos cards

Conforme a representacdo do tabuleiro é possivel
perceber quatro campos especificos. Cada rodada serd
composta pela insercdo de 2 cards por usudrio, sendo
um de inser¢do e outro de combinacéo.

Assim, quando um jogador inserir um card com um
organismo (animal) no tabuleiro, o outro jogador
devera inserir um card com o filo (unidade taxonémica
usada na classificacdo cientifica dos seres vivos) no
qual pertence o organismo. Tanto a visualizagdo dos
organismos quanto a visualiza¢do dos filos inseridos no
tabuleiro, serdo em 3D, por meio de um artefato
tecnoldgico que pode ser um smartphone, um tablet ou
computador equipado com uma webcam.

Figura 8: llustracdo do jgo por meio
de um computador conectado a uma webcam

Quando o jogo ocorrer por meio de um computador
equipado com webcam e projetor multimidia, o0s
objetos em 3D serdo visualizados diretamente na tela
do projetor.

A outra opcdo de funcionamento do jogo pode
ocorrer por meio de dispositivos moveis, em que 0s
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estudantes poderdo interagir com o Tabuleiro
Aumentado diretamente de seus smartphones.
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Figura 9: Interagdo via smartphone

Assim, a primeira rodada serd iniciada pela
insercdo de um card no tabuleiro. A ideia é que, ao ver
a projecdo em 3D do organismo inserido via card pelo
primeiro jogador, o segundo jogador deverd inserir o
card de combinacéo correto.

Neste momento o jogador que colocar a carta de
combinacdo podera pontuar desde que a combinagdo
esteja correta. Caso a combinagcdo seja entre um
organismo e um filo errado, a pontuacdo passara para o
outro jogador.

Cada rodada tera dois momentos, em que no
primeiro, o jogador devera colocar no tabuleiro o card
insercdo e no segundo momento o card de combinagdo
permitindo que ambos 0s jogadores possam pontuar
das duas maneiras.

5. Conclusao

O jogo apresentado neste artigo propde uma forma
diferenciada para a aprendizagem de temas
relacionados aos seres vivos, como a Classificacao,
Haébitat e as Caracteristicas dos filos dos organismos.

O que se pretende com os recursos desenvolvidos, é
gue 0S MesmMoOs Sejam recursos auxiliares para a
aprendizagem, que pode ser favorecida por meio da
visualizagdo e integracéo de objetos virtuais ao mundo
real no contexto onde os estudantes estéo inseridos.

O proximo passo sera a avaliacdo e validacdo do
protétipo com a mediacdo de professores de Ciéncias
dos anos finais do Ensino Fundamental 2, buscando
sugestdes que possam ser implementadas para a
melhoria do jogo.
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Pretende-se que o recurso desenvolvido seja
disponibilizado para utilizacdo sem fins lucrativos.
Pretende-se ainda como proposta para uma segunda
pesquisa, apresentar os resultados das apropriacdes do
jogo Tabuleiro Aumentado no contexto educacional
como contribuicdo deste estudo.
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